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This document and its contents are proprietary to Veredus Laboratories Pte Ltd (Veredus, Vereduslabs) and are intended 
solely for the contractual use of its customer in connection with the use of the product(s) described herein and for on 
other purpose. This document and its contents shall not be used or distributed for any other purpose and/or otherwise 
communicated, disclosed, or reproduced in any way whatsoever without the prior written consent of Veredus. Veredus 
does not convey any license under its patent, trademark, copyright or common-law rights nor similar rights of any third 
parties by this document. 
 
The Software is licensed to you under the terms and conditions of the Software License Agreement in a separate 
document. If you do not agree to the terms and conditions therein, Veredus does not license the Software to you, and 
you should not use or install the Software. 

 
Failure to completely read and explicitly follow all of the instructions contained herein may result in 
damage to the product(s), injury to persons, including to users or others, and damage to other 
property. 
Veredus does not assume any liability arising out of the improper use of the product(s) described 
herein or any use of such product(s) outside the scope of the express written licenses or permissions 
granted in connection with customer’s acquisition of such product(s). 
 
Copyright 2017. All right reserved.  
 
VerePLEX™ Biosystem, VereFlu™, VereThreat™, VereFoodborne™, VereMTB™, VereTrop™, 
VereMERS™, VereBeef™, VeTaq™ and VereChip™ are a registered trademark of Veredus.  
Windows, Windows NT, Windows XP, Windows Vista, Windows 7, Windows 10 are registered 
trademarks of Microsoft Corporations. 
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Chapter 1 

1 General       
 
This instructions for use (IFU) include important information related to the operating safety and 
maintenance of the VerePLEX™ Biosystem instrument. The IFU is an important part of the product. 
It must be read carefully and completely before setup and first use of the instrument and must be 
kept near the instrument at all times. If additional requirements on accident prevention and 
environmental protection exist in the country of operation, this IFU must be supplemented by 
appropriate instructions to ensure compliance with such requirements. 
 
The IFU for this VerePLEX™ BioSystem is valid for versions of the following instruments: 

 Temperature Control System  TCS - 03 

 Optical Reader    VOR – 02 

 Touch Monitor   TOM – 01 

 Laptop  (optional)   VPLX-VLP 

 2D Barcode Reader (accessory) VPLX-VBR  

 Software VerePLEX™ Version 5.3.1 which consist of: 

 E@syControl 2.9 

 E@syCheck 4.2.0 and above 

 E@syManager 3.6 

 
The default system consist of the Touch Monitor, Optical Reader and 2D Barcode Reader connected 
to a Base Temperature Control System. Additional Satellite Temperature Control Systems may be 
added to the Base system.  
 
Within the VerePLEX Biosystem software suite,  

 The 2D Barcode Scanner facilitates data entry and also is used to enter the VereChip 

calibration data in E@syControl for sending the thermal cycling protocol to the Temperature 

Control Systems (TCS). 

 E@syCheck is used to control the Optical Reader (OR) for image capture. 

 E@syManager is for the assigned administrator to manage and control items such as User 

Accounts and BioApplications. 
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1.1 Symbols occurring in the text 

 
 

 
 
 

 
 

1.2 Symbols occurring on the instruments 

 
All the labeled symbols placed on the TCS and OR units are designed and created in compliance with 
the standard below:  
 

 EN ISO 18113-3: 2009 In vitro diagnostic medical devices - Information supplied by the 
manufacturer (labeling) - Part 3: In vitro diagnostic instruments 
for professional use 
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Rear panel labels are showed in the below picture. 
 

                                                                                               
 

 
 
 

 
                                                                                               

 
 

 
Fig 1: Rear view and panel of TCS 

 
                 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 2: Rear view and panel of OR 
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Fig 3: Rear view and panel of TOM 
 
 
Inside each TCM is the following label. 
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The labels shown in the table below are on the instruments and refer directly to the safe use of the 
system. 
 

Symbol Description 

 

 

Manufacturer 
 

 

 
 

Serial Number 
 
 
 

 

 
 
 

Catalogue Number 
 
 

 

 

Alternating Current 
 

 
Direct  Current 

 

 

 

Protective Earth (Ground) 
 
 

 

 

CE mark Symbol 
 

 
 

FCC mark Symbol 
 

 

 
Do not dispose in waste bin 
 

 

 

General warning, caution, risk of danger 
 

 

 

Biological Risk.  
 

 

 

Warning, hot surface 
 

 

 

Stop TCM runs 
 

► 

 

Start TCM runs 
 

 

 

Scroll through TCM information 
 

 

 

Ethernet ports for OR and additional TCS connection 
 

 
Be sure to read and comply with the safety instructions, warnings and cautions in chapter 2.
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1.3 Designed use / improper use of the instruments 

 
The instruments are designed for applications in biology and molecular diagnostics are to be 
operated together as a set and also according to the instructions contained in this IFU. 
Any other use outside of this IFU is considered an improper use of the product.  
 

1.4 Qualification of personnel 

 
The instruments together with the various VereChip applications are intended for professional use 
and may be operated only by trained laboratory personnel.  
All laboratory personnel designated to operate these instruments must read this IFU carefully and 
must be familiar with all technical features before attempting to operate. 
 

1.5 Identification 

 
The TCS, OR and TOM instruments are identified with the following labels at the back.  
 

 Instrument: Name of instrument 

 REF: Catalogue Number 

 Model: Model version of the instrument 

 SN XXX is a progressive serial number 

 
The VerePLEX™ Biosystem with TOM works with the following software version: 

 VerePLEX™ Software Version 5.3.0 (Or later) 

 

1.6 Storage and handling 

 
Recommended storage and transportation environmental conditions: 
Temperature range   [-10 °C to 50 °C] 
Relative Humidity      [20% to 80%] 
Pressure                        [7.2 psi to 15.3 psi] 
 
Recommended operative environmental conditions: 
Temperature range   [+10 °C to 30 °C] 
Relative Humidity      [20% to 80%] non-condensing 
Pressure                        [12.0 psi to 15.3 psi] 
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1.7 Warnings and precautions 

 

 DO NOT use the instruments in instances where the external casing integrity is questionable. 

 DO NOT connect the device to a power source that is not properly earthed (grounded). 

 DO NOT open TCM cover lids while PCR or hybridization is in progress. 

 DO NOT touch the pogo pin where the chip has to be contacted when the TCM is turned on. 

 DO NOT use with older versions of software.  

 

1.8 Intended purpose 

 
The TCS has been designed and developed to control the temperature in the embedded reaction 
chambers of the chip. The OR has been designed and developed to acquire the microarray image of 
the chip and the TOM is designed to work as the main user interface with the Base TCS.  
All instruments work in combination with the VereChip and 2D Barcode Reader and are part of the 
whole system. They are not to be used separately. 
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Chapter 2 

2 Safety 

2.1 Safety regulation 

 
Before setting up the system, some important warnings are mandatory: 

1. The instruments may be operated only according to the instructions contained in this IFU. 
Any other use is considered an improper use of the product. 

2. Do not operate the instruments in extreme humidity or where condensation can short the 
internal electrical circuits of the unit. 

3. The TCS and OR instruments are CE-marked and are designed and manufactured in 
compliance with the standards below:  

2014/35/UE Low Voltage Directive 

2014/ 30/UE EMC Directive 

CEI EN 61010-1 Safety requirements for electrical equipment for measurement, control, 
and laboratory use - Part 1: General requirements  

CEI EN 61010-2-010 Safety requirements for electrical equipment for measurement, control, 
and laboratory use — Part 2-010: Particular requirements for laboratory 
equipment for the heating of material 

CEI EN 61010-2-081 Safety requirements for electrical equipment for measurement, control and 
laboratory use. Particular requirements for automatic and semi-automatic 
laboratory equipment for analysis and other purposes 

EN 61010-2-101 Safety requirements for electrical equipment for measurement, control, 
and laboratory use - Part 2-101: Particular requirements for in vitro 
diagnostic (IVD) medical equipment 

CEI EN 61326-1 Electrical equipment for measurement, control and laboratory use. EMC 
Requirements. General requirements 

CEI EN 61326-2-6 Electrical equipment for measurement, control and laboratory use. EMC 
requirements. Particular requirements. In vitro diagnostic (IVD) medical 
equipment  

EN ISO 18113-3 In vitro diagnostic medical devices - Information supplied by the 
manufacturer (labeling) - Part 3: In vitro diagnostic instruments for 
professional use 

 
4. Always connect the power supply to a 3-prong, grounded AC outlet rated 3 A 100–120 V or 

1.5 A/220–240 V using the AC power cord provided. 
5. Do not remove fuses in the TCS. If they need to be replaced, please refer to label (T 2A) 

placed on the rear panel. 
6. Always connect the Ethernet port to a Local Area Network by using Ethernet cable provided. 
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7. To ensure adequate cooling of the TCS and stable base for image acquisition of the OR, place 
the instruments on a clean, flat surface, and be sure that there is at least 4 inches (10 cm) 
clearance around each side of the unit. Make sure that the bench space is free of any foreign 
objects or debris that could block the fan vents or can obstruct the power and Ethernet cord 
so that it is difficult to operate the disconnecting device. 

8. The usage of protective gloves or other protective means in order to operate with the 
instruments is not mandatory. 

9. Always avoid touching the TCMs lids during temperature program run to reduce the risks of 
burns from surfaces if the temperature exceeds the allowed limits. 

10. All instruments have been tested and complied with the FCC official limits. They are FCC-
marked with accordance to the FCC standard 47 CFR part 15 subpart B. 

2.2 Electromagnetic Interference 

These instruments complies with Part 15 of the FCC rules. Operation is subjected to the following 
conditions: 

1. These instruments may not cause harmful interference. 
2. These instruments must accept any interference received, including interference that may 

cause undesired operation. 

These instruments have been tested and found to comply with the EMC standards for emissions and 
susceptibility established by the European Union at the time of manufacture. 
 

2.3 FCC Warning 

Warning: Changes or modifications to the instruments not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment. 
 
Note: These instruments have been tested and found to comply with the limits for a Class B device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in an industrial setting. These 
instruments generate, use, and can radiate radio-frequency energy and, if not installed and used in 
accordance with the IFU, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at his own expense. 
 
Note Regarding FCC Compliance:  Although the design of the instrument has been tested and found 
to comply with Part 15, Subpart B of the FCC Rules for a Class B device, please note that this 
compliance is voluntary, for the instrument qualifies as an “Exempted device” under 47 CRF § 
15.1039c0, in regard to the cited FCC regulations in effect at the time of manufacture.
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Chapter 3 

3 System Overview 

3.1 TCS General Description 

 
The TCS is an electronic appliance to set and control thermal cycles for PCR and Hybridization 
reactions that run the chip. It provides five TCMs that run five independent temperature 
programs (Fig. 1). Each module is controlled by an electronic board (TCM-EB) based on ST7 
microcontrollers technology. The TCS is based on a control algorithm implemented as 
firmware (FIRM) for the ST7 microprocessor. The FIRM in according to this thermal control 
algorithm will drive embedded heaters and an external cooling fan to allow high gradient and 
performance thermal cycles. 
 
The TCS can operate in the following manner: 

 : The software running natively off the embedded computer board in the TCS Satellite 
TCS: TCS has to be connected to a network switch or directly to a laptop by means of 
a point to point LAN cable connection TCS. 

 
Each TCM gets user commands by:   

 the front panel dedicated to each module, the operator pushes the START button to 

start running, the INFO button to scroll the information in the LCD, the STOP button to 

stop the running,  

 the E@syControl software application that runs on a standard laptop  

 
The E@syControl allows users:  

 to send the Temperature Protocol that contains the temperature cycles for PCR 

specific to each application type,  

 to verify the calibration data, 

 to communicate to single TCMs.   

 
The TCS is able to multiplex commands received via E@syControl by using an internally 
embedded PC that will pass them to the specified TCM via RS485 standard communication. 
The secondary aim of the embedded PC is to collect temperature data from TCMs and to send 
them to the E@syControl. This latter will show trends of temperatures into appropriate 
windows.  
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Fig 3: Temperature Control System (TCS) 
 
 

1. Power Supply plug and Fuses  

2. Power switch 

3. TCM hatch 

4. TCM opening key 

5. State led 

6. Function keys 

7. TCM display 

8. Front panel 

9. Communication back panel 
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3.2 OR General Description 

 
The OR is an optical device for acquiring images of the microarray on the chip. It has been tuned in 
accordance to silicon oxide thickness to provide a limit of detection of 25 fluor/μm2. The camera 
offers up to 1392 x 1040 pixels and operates in 8-bit mode. It has two programmable outputs that 
are used for turning on an excitation system based on two identical illuminators located 
symmetrically to the sides of the camera and tilted at 45 degrees respect to that. Each illuminator 
is composed of a 5 mm white LED, a red LED, two aspherical lenses and an excitation filter. A 
dedicated software, E@syCheck, is used to drive the OR.  
 

                              
Fig. 444: Optical Reader (OR) 

 
1. Power Supply Jack 2. IEEE 802.3 Ethernet 

3. Power Switch (1 = ON; 0 = OFF) 4. Product Identification label 

5. Focus Adjustment Knob 
7. Power Status Led 
9. Slotted Insertion Plate 

6. Focus Adjustment Locking screw 
8. Front Hatch 
10. Rubber feet 
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3.3 TOM General Description 

 
The TOM is an auxiliary device for the VerePLEX™ Biosystem having the capability to be connected 
to the Base TCS by USB cable and VGA cable as shown in the following pictures: 
 
 
 
 

          
 
 
 

 
 
In the same rear panel, the TOM is to be connected to a 12V DC 3A power source. 

Base TCS Rear Panel 

USB 

VGA 
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Chapter 4 

4 Installation 

4.1 General 

 
The VerePLEX™ Biosystem should be installed on a clean, dry, level surface with sufficient cool 
airflow to operate properly. The instruments have been factory calibrated and does not require 
further calibration upon installation.  
 

4.2 Action upon delivery 

 
Before unpacking, check the instrument case for signs of external damage. If the case is broken or 
damaged, do not use the instrument and immediately notify the shipper of the damage.  
 
Unpack the TCS case and check the list of components: 

 

 TCS unit 

 Power cord 

 802.3 IEEE Ethernet STP cable 

 Chip holder 
 
Unpack the OR case and check the list of components: 

 

 OR unit 

 Power cord with adapter 

 IEEE 802.3 Ethernet cable 

 2D barcode reader 
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4.3 Preparation prior to installation 

 
Site Requirements 
The TCS and OR requires a solid bench of dimensions at least 550 mm long and 350 mm deep. 
Unpack power cord and Ethernet cable; keep them close to installation site in order to take them at 
the proper time. See Appendix A for a detailed list of requirements for the installation. 
 

4.4 Bringing into operation 

 
Refer to the rear panel of the instruments and connect the cables according to their respective 
ports.  
 

4.5 TCS Connection   

 
See below for an overall view of the TCS rear panel:  

 

 
 
 
 
 

Fig. 557: TCS Back Panel 
 
 

  

POWER SUPPLY  

SOCKET 

USB 

CONNECTORS 

ETHERNET 

PORTS 

RS 232 
SERVICE 
CHANNEL 

 

VGA PORT 
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4.5.1 TCS Power Connection 

 
Connect the provided power cord to the back of the TCS and a power outlet.  
 
 

 

Power supply 
 
Input Voltage: 100/240 Vac (extended range 90 ¸ 264 Vac) 
Input Frequency: 50 /60 HZ (47/ 63Hz) 
Input power: 140W maximum 
 
Automatic switching 
  

 

4.5.2 OR Power Connection 

 
Connect the packaged Switching AC adapter output jack to female connector at the back of the OR. 
 
 

 

Switching AC Adapter input features: 
 
100-240 Volt AC  
0.4 Ampere 
50-60 Hz 
 
Switching AC Adapter output features: 
 
12 Volt DC  
1.25 Ampere 
Centre Hole Positive  
Outer metal sleeve connected to Negative 

 
Connect the Switching AC adapter power cord to a power outlet. 
 
 
 

  



IFU-PLX-RA01-1002 

 

 

VerePLEX™ Biosystem      Page 17 of 85 
                                                                                

4.5.3 TOM Power Connection 

 
The rear panel of the TOM has to be removed before accessing the connection ports. Refer to the 
illustrations below on the rear panel removal. 

 
 
 

 
 
 
 
 
Unscrew cover connector panel and get the following: 
 

 
 
 
 
 
 

Fig. 8: TOM back panel 
 

Cover Connector Panel 

Connector Panel 

Buttons Panel 
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Connect the USB and VGA cables from the monitor to the appropriate connectors at the back of the 
Base TCS. 

 
 
 
 
 
 

Fig. 9: Base TCS back panel 
 
Connect the packaged Switching AC adapter output jack to female connector at the back of the TOM. 
 
 

 

Switching AC Adapter input features: 
 
100-240 Volt AC  
1.5 Ampere 
50-60 Hz 
 
Switching AC Adapter output features: 
 
12 Volt DC  
3 Ampere 
Centre Hole Positive  
Outer metal sleeve connected to Negative 

 
Connect the Switching AC adapter power cord to a power outlet. 

  

USB 12 Vdc Power Supply VGA 
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4.6 TCS configurations 

 
In a default configuration, the TCS instruments are connected using Ethernet cables to the 
supplied laptop via a network switch. The Optical Reader is also connected using Ethernet 
cable to the same switch. The configuration may be customized to specific site requirements. 

An network switch is recommended for this configuration. 
 

 

It is recommended to use a crossed Ethernet cable when you make a 
point to point connection.  
The port has auto-switching function. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig 10: Overview of full LAN setup 

 
 
 
 
 
 
 
 
 
 
 
 

Base TCS 

Satellite TCS Satellite TCS Satellite TCS Satellite TCS 

Network 
Switch 

OR 

TOM 
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Fig 11: A 2 x TCS setup without switch 
 
 
 

The TCS and OR are recognized based on their static IP addresses and have been factory configured. 
Changing of the IP addresses is not recommended. Please contact your local technical support if 
there are specific requirements. 
 

4.7 Software installation 

 
The instrument should already have the correct software installed.  
Customer should not have to install the software. 
 

 

 
The Software VerePLEXTM 5.3.1 and higher has been validated on Windows 10 Pro. The 
software should not be used on an older version of Windows operating system. 

 

 

4.8 BioApplication 

 
Central to running the assay and performing microarray analysis is the BioApplication. Each 
Targets detection panel is defined by a particular BioApplication. All settings required by the 
instruments to execute the VereChip run are wrapped in the BioApplication such that user do 
not need to do any settings or adjustments. 

Base TCS 

Satellite TCS 
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These settings include the thermal protocol, image capture settings, microarray probes layout 
and diagnostic rules which determines what targets are Detected or Not Detected. 
 
The VerePLEX Biosystem comes preinstalled with certain BioApplications. For newly launched 
products or new BioAppplications, user should contact their local sales or technical support 
personal for the relevant BioApplication that they require.  
 
The E@syManager software is where the assigned administrator can manage the 
BioApplications. The administrator can import and delete BioApplications. Inaddition the 
Administrator also assigns a default BioApplication to each user. An account with Power User 
access level can change their assigned default BioApplication while an account with Standard 
User access level cannot change their assigned default BioApplication. Changes have to be 
done by the administrator.
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Chapter 5 

5 Theory 
 

The TCS thermally controls the chip using resistive heating and forced air cooling. Each TCS is 
equipped with 5 modules (TCM as Temperature Control module) that are able to run 5 separate 
chips separately for different thermal profiles. Thermal profiles (PCR) are pre-programmed and 
monitored by E@syControl software. 
 
The OR provides a collimated and monochromatic source of red light that excites the fluorophores 
that are bounded to the DNA oligos on the microarray surface. The fluorophores then emit light 
at a slightly longer wavelength with the intensity of the emission proportional to the fluorescent 
concentration in each microarray spot. 
 
An emission band pass filter separates the fluorescent wavelength from the excitation wavelength, 
and the resulting image is captured by a high-sensitivity CCD camera. The digitized image is saved 
as .tiff and is analyzed by E@syCheck software. E@syLIMS would interpret the results and provide 
a final report based on the chip type and BioApplication used and the results can be then exported 
and archived as CSV or PDF format. 

5.1 Function 

 
Each TCM consists of electrical contacts with internal sensors and resistor heaters. These contacts 
are performed by spring-based pins with the capability of moving order to achieve better contact 
adaptation. Electrical continuity is ensured by the lid. Once the lid is closed, it exerts a force over 
the chip, compressing the spring-based pins. 
In this way, the chip is in full contact with the TCM electronic board. This allows the regulation of 
thermal energy into the chip. Feedback is returned by a 4-wire sensor reading circuitry.  
 
Upon the instrument start-up, each TCM performs a self-check and will give an error if they do not 
pass entirely. In this case, the particular TCM will not be usable while the remaining TCMs that 
pass the self-check will be functional. 
 
Once the self-check is completed, it is ready to receive a chip. If the chip is validated, the TCM is 
ready to receive a thermal protocol. During the temperature program, it is possible to view the 
temperature courses as described in the next chapters. 
 
The OR is like a microscope with a dedicated light source. It would capture an image of the whole 
microarray and the image is interpreted by a defined set of diagnostic rules in the BioApplication.  
 
Annual calibration is recommended for both the TCS and OR and to be carried out by certified 
service engineer.  
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5.2 Performance and limitations of use 

 
TCM thermal regulation limits and characteristics: 
 

 Reading sensor accuracy = ± 0.1o C 

 Regulating temperature accuracy (during set point  maintenance )= ± 0.2 o C 
 
Operative temperature range is 45o C to 100o C. 
 
A log file records each run-time to give end user the possibility to make an offline data analysis. 
The log file contains information about thermal profile, detected errors etc. 

 
The OR has a detection limit of 25 fluorophores/μm2. Each dot in the detection area has a cross 
section of about 6.7 um per pixels.  
 
A full analysis cycle, from chip introduction, image capture, image analysis to chip removal, takes 
about 15 seconds. Therefore, approximately 3 chips can be analyzed per minute. 
 

Chapter 6 

6 Operation 

6.1 Preparation prior to operation 

 
Prepare the chip according to the IFU accompanying the reagent kit. 

6.2 E@syControl operation 

 
Below is a summary of steps for thermal control operation of the TCS: 

 
Setup 
1)  Turn on the TCS  
2)  Login to E@syControl to use the TCS 
 
Run 
For each sample test: 
3)  Scan 2D barcode of chip to load the calibration data into E@syControl 
4)  Load the temperature program or BioApplication by E@syControl 
5)  Start the temperature program or BioApplication by pushing start in the TCM front panel or by 

clicking start in the E@syControl software 
 
Termination 
6)  Logout E@syControl 
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7)  Turn off the TCS 
 

6.2.1 Powering up the Temperature Control System (TCS) 

 
Upon turning on the TCS instrument, an initial hardware test will be performed to evaluate the 
status of the system. In particular, the following components are checked for each of the 5 
modules: 
 

 Flash 

 Fan 

 E2prom 

 A to D converter 

 Presence of A to D calibration data 

Any test failure detected at this point will cause the specific module to stop booting completely 
with the message of the error displayed on the TCM LCD display. This prevents the user from 
using a faulty module and please contact Technical Support for repairs. 

 

6.2.2 Run E@syControl and Login to use the TCS 

 
Start the E@syControl. Once loaded, the GUI is displayed. The software will begin to search for 
available TCS units. The software will check and connect the configured TCS.  
 

 Red TCS icon means that the TCS is disconnected 

 Yellow TCS icon means that the TCS is connecting 

 Green TCS icon means that the TCS is connected 

If the software is not able to connect the TCS, see section 4.5. 
 

The platform offers the capability to use the “Virtual Keyboard”. To enable this function, the user 
has to check the item View -> “Virtual Keyboard” in E@syManager tool. After the item has been 
checked, the user can use the virtual keyboard for text editing operation. 
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Fig. 12: E@syControl Main window 
 
Once a TCS is connected, the TCS button is highlighted and can be selected. It is mandatory to press the 
“Login” button in the toolbar for user authentication. (Fig. 12).   
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Fig. 13: User authentication 

 
After the login authentication, the user is enabled to use the TCMs of all connected TCS. 
E@syControl will provide different features according to the group permission: 
 

 Standard User 

 Power User 

 Administrator 

 
Every operation (start, send, lock, view log, reset, etc.) can be performed by user selecting the related 
TCM option from context menu as showed in the figure below. To access this context menu, right click 
on the TCM section using the laptop keypad or mouse. 
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Fig. 14: TCM option context menu 

 

6.2.3 Calibration data verification and TCM calibration 

 
The user needs to scan the 2D Data Matrix Barcode printed on the chip using the supplied 
barcode reader and the application will display the barcode. The 2D barcode contains the chip ID 
and the calibration data. 
 
The software can give out the following error messages: 
 
“Calibration data not found” means that the calibration file is missing.  
 
“Delta TC out of specs” means that the Delta TC value is greater than 0.00041389. 
 
“Sensor Spread @ 60 out of specs” means that the value is greater than 7.85. 
 
“Sensor Spread @ 90 out of specs” means that the value is greater than 8.45. 

  
The last three messages are related to wrong calibration data. In this case, the user should discard 
the chip and notify the problem to the Manufacturer.  



IFU-PLX-RA01-1002 

 

 

VerePLEX™ Biosystem Software     Page 28 of 85  
                                                                               

 
If there is no error message and “Not Ready” is displayed in the Status message box, the 
calibration data is sent to the TCM correctly and the chip ID becomes green color (Fig. 15). 
  

 
Fig. 15: Chip validation and calibration data loading 

 
The user can insert the chip into the TCM and close the lid.  The heaters and sensors embedded 
in the chip are checked. During validation, “Chip Validation” will be displayed in the TCM display. 
 
After validation, if “CHIP IS NOT VALID” error message is displayed in the TCM display and the 
software, the user has to follow the procedure described below: 

(a) Open the lid,  
(b) Close the lid for a new validation 

 
If the error message “CHIP IS NOT VALID” is still displayed, it means that the chip is not usable 
and has to be discarded. 
 
Once the chip is validated, the user has to select the Temperature Program or BioApplication. 
The user can either select the Temperature Program or BioApplication before or after the chip 
validation phase. When the message “CHIP INSIDE PRESS START” is displayed on the TCM display, 
the user can begin the operation. 
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6.2.4 Chip traceability 

 
In order to trace each single chip from the start to the end of an experiment and to avoid reusing 
the chip more than once, it is necessary to store all the relevant information and steps performed 
in the central database. 
 
After a run is completed, E@syControl stores in the database all the information to trace the 
operations related to the used chip.  
When the user inserts the barcode of a used chip, the application shows the following warning 
message: 

 

 
Fig. 16: Chip traceability 

 
The recommended action to press the “No” button which will remove the chip ID from 
E@syControl. This stop the user from thermal cycling a used chip. Pressing the “Yes” button will 
allow the user to proceed with the run. Only perform this step if the user is sure that they want 
to thermal cycle a used chip a temperature program or BioApplication. Pressing the “No” button, 
all the info related to the chip ID are deleted in the software GUI. 

 

6.2.5 Temperature program run 

 
Before running a temperature program the user can check the program by pressing the middle 
button in the TCM: 
 

1) Chip ID and calibration data 
2) Temperature program loaded 
3) Chip has been loaded and recognized inside the TCM  
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Fig. 17: Ready to start 

 
 

Pressing the              button in the software in the TCM line or the physical TCM left 
button starts the PCR process and the progress bar will start to count the percentage of elapsed 
time (Fig. 18 & 19). 
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Fig. 18: Progress bar counting 

 
Before the hybridization step, the TCM pauses and waits for the user to extract the chip for 
further operations. The following message will be displayed on the TCM: 

 
 

 
 
When the chip is ready to complete the fluidic operation, the user can insert the chip into the 
TCM inside the module and press the button to proceed.  
 
At the end of the temperature program, the TCM will display the following message: 

 
 
 
 
 

The chip can be extracted and the TCM module can be prepared for a new chip run. The last 
temperature program set will be kept. 
 

Protocol 

COMPLETED 

WAITING FLUIDIC 

OPERATION 
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6.2.5.1 Software Lock TCM 

 
E@syControl provides the lock/unlock single TCM feature to minimize the risk of accidental errors 
due to multiple users on the same instrument.  
 
The TCM will lock when: 

a. User signs out of E@syControl 

b. Auto lock after a preset time  

The red lock icon indicates that the particular TCM is in used and can only be unlocked by the 
same user or the administrator. A locked TCM will not respond when the physical buttons on the 
TCS is pressed. But the TCM lid itself is not locked and can be opened.  
 

 
 
 
 

6.2.6 BioApplication Management 

 
For ease of use, all the settings and parameters are contained in the BioApplication and this is 
specific to the chip and reagents used. 
  
A BioApplication is defined as a set of input data/files: 

 Layout of the Microarray 

 Temperature Program 

 Reader parameters 

 Settings for the microarray image analysis. 

 Diagnostic rule 
 

To check and view the temperature program associated to the default BioApplication, the user 
can select the “BioApplication” item in the toolbar or in the menu under “Tools”. The “Default 
BioApplication” will be highlighted in red as shown in the image below:  

 

Do not open the TCM lid while the thermal protocol is still in progress. 
Doing so will pause the run and may render the results invalid. The 
thermal protocol will resume after the lid is closed and chip verified.  
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Fig. 19: BioApplication Management 

 
The BioApplication Management window contains the list of all BioApplication records in the 
database.  
 
The BioApplication cannot be edited or managed by user inside the E@syControl tool. Only the 
Admin can manage the BioApplication package by the E@syManager tool. 
 
The Power User can select their own default BioApplication in the BioApplication Management 
window. The Standard User, however, cannot change the default BioApplication as it is pre-
defined by the Admin. Only the Admin can change the assigned default BioApplication for the 
Standard User. 
 
Through the toolbar and menu, the Power User can launch the BioApplication Management 
window to select the default BioApplication. The default BioApplication selected will be 
automatically sent to the TCM once the chip 2D barcode is scanned. If there are chip runs which 
require a different BioApplication, it can be selected from the dropdown list after the chip 2D 
barcode is entered. 
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Fig. 20: Selecting a different BioApplication 
 
 

Once the BioApplication is changed in the dropdown list, the new thermal protocol will be 
automatically sent to the particular TCM and overwrite the previous default protocol. 
 
 
 

 
 

 
 
 
 
 

In the event that there is a need to change the protocol by sending the same protocol to multiple 
TCMs, instead of changing it 1-by-1 using the dropdown list, user can also send the same protocol to 
multiple TCMs using the “Send Group” function shown below. To access this menu for the particular 
TCM, right click on the Status column.  

Note: After selecting the different BioApplication, depending on the 
length of the new protocol, it may take a few seconds for the complete 
protocol to be sent over and overwrite the previous default protocol.  
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Fig. 21: Selecting a different BioApplication 

 

Note: After selecting the different BioApplication, the thermal protocol 
has to be sent to the TCM to overwrite the previous default protocol.  
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In this example, TCM 2 has been changed to VereFlu_3.3 and TCMs 1 and 3 are to be changed to 
VereFlu_3.3 too. After having selected send group, another window would appear enabling the user to 
send the same protocol that TCM 2 currently has to multiple TCMS (i.e. TCM1 and TCM 3). 
 

 

 
Fig. 22: Sending BioApplication 

 

6.2.7 Warning run time lamps visualization 

 
The service engineer is able to enable or disable warning run time visualization. A warning will be 
present when the TCS is unable to reach a set temperature within a specified amount of time. 
This will not cause the TCS to terminate the thermal protocol run but would log this event as a 
temperature timeout and indicate in this warning lamp. The temperature time-out would usually 
occur if the set cooling temperature is below the ambient temperature of the instrument. 
 
If the temperature warning item in the Configuration->Options menu is enabled, a colored lamp 
is shown for each temperature course to show (real time) if it is correct or wrong (green, orange 

or red). If temperature stays into  0.5C° set-point range, the green lamp is on, otherwise the 
orange lamp is shown. The red lamp is shown only if the Temperature Program is stopped for an 
over-temperature error in the TCM. 
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Fig. 23: Warning lamp 

 
It is possible to show the error log smart window by clicking on the red/orange lamp in the main 
window as shown below: 

 
Fig. 24: Clicking on red/orange lamp 

 
Clicking in the red/orange lamp it is shown an error log as shown below: 
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Fig. 25: Warning log window 

 

6.2.8 Log View for TCM (administrator only) 

 
Only the administrator can view the TCM log. This tool can show Logs files with all its data fields 
that can filter visualization, save as .txt file and load for background analysis.  
 
To retrieve the log, the user has to select “View Log…” by clicking on the TCM option context 
menu. A window will be displayed as the following figure: 

 

 
Fig. 26: Log view 
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This log file can then be saved and sent to service engineer for troubleshooting. 
 

6.2.9 TCS configuration 

Only the service engineer can configure the TCS IP addresses from the Configuration menu or 
from the Configure button on the toolbar. The window is shown in Fig. 27 below: 

 

 
Fig. 27: TCS configurations 

 

6.3 TCM Reset function (Power and Administrators) 

It is possible to reset a single TCM by clicking on the “Reset” item in the TCM option menu. This 
operation can be performed only by Power and Admin users. 
 
This reset function is not usually used during normal operation. In the event that the TCS status 
does not match the status in E@syControl software, the whole TCS instrument may be rebooted 
to resolve the sync issue. But if there are chips running, specific TCM can be rebooted using this 
function. 
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Fig. 28: TCM Reset function 

 AC-DC converter 

 Presence of AC-DC calibration data 

 
Any boot-up test failure will cause a hardware error and a TCM stop with the message of the 
error displayed on the TCM LCD display. 

 

6.3.1 Message and sound events (Power and Administrators) 

 
Power and admin users can set messages and sounds by selecting them from the Configuration 
menu:  
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Fig. 29: Message and sound events 
 

6.3.2 Shut-down procedure 

 
The TCS does not require any particular shut-down procedure. It can be switched off directly 
without damages. 
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6.4 E@syCheck and Optical Reader Operation 

6.4.1 Preparation prior to operation 

The chip should have undergone thermal cycling, hybridization, washing and drying steps before 
imaging the microarray using E@syCheck. 
 
To acquire and analyze an image of the microarray by an OR, use the E@syCheck tool. When the 
user launches E@syCheck tool, the following GUI is displayed: 

 

 
Fig. 30: E@syCheck main window 

 
 

It is mandatory to press the “Login” button in the toolbar for user authentication.  
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Fig. 31: User authentication 

 
After login authentication, the user is enabled to use the E@syCheck tool and the OR. E@syCheck 
will provide different features according to the group permission: Standard User, Power User and 
Administrator. 

 

6.4.2 Scanning Microarray and Reports creation 

When a user logs in to the E@syCheck tool, a “New Report” window will be shown. This window 
is used to create a new chip analysis and report. 

 
Fig. 32: New Report window 
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A cursor is positioned in the text area under the “BarCode” column field. Using a barcode reader, 
the chip ID can be scanned and will be entered into the text area. The chip ID can also be manually 
entered followed by the “Enter” key. 

 

 
Fig. 33: BarCode insertion 

 
  

Enter Chip ID 
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Before the chip scan and data analysis, the user should ensure that the correct BioApplication is 
selected. To select the appropriate BioApplication, the user should click on “BioApplications 
Management” button under the “Tools” menu. (Fig. 34) 
 

 
Fig. 34: Open BioApplications Management window 
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Select the correct BioApplication by clicking in the check box. Refer to the back of the chip label 
or the chip IFU for details on which BioApplication to use. (Fig. 35) 
 

 
Fig. 35: Check the correct BioApplication 

 
 
 
 
 
 
 
 
 
By selecting the BioApplication this way, it becomes the default BioApplication for every chip analysis 
after the chip ID is entered. If a different BioApplication is required, it has to be changed in the 
BioApplication Management Window. 
 

6.4.3 Acquisition and analysis operation 

To perform an “Acquisition” operation, it is necessary that the OR is turned on and connected to 
the Base TCS or laptop.  
To begin chip scan and data analysis, the user clicks on the “Acquisition” button on the toolbar 
or selects the menu “Tools-> Acquisition and Analysis” item. 

 

Selecting the wrong BioApplication may result in analysis error or 
incorrect final result.  
If the wrong BioApplication is used, select the correct BioApplication and 
re-analyze the same chip.  
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Fig. 36: Acquisition and Analysis selection 
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If the OR is turned off, an error message will be displayed. Ensure that the power of the OR is 
turned on before clicking on the “Acquisition” button. If message persist, ensure that all 
connections are connected securely.  

 

 
Fig. 37: Reader off message 

 
When “Acquisition” operation begins, the progress bar in the “State” column will advance.  
The following operations are performed: 

 If no error occurs during the image acquisition of the chip, the obtained image is 

automatically saved in the hard disk. And the .tiff image would be the same name as the chip 

ID. If a .tiff image with the same name already exists in the database, a time-stamp is 

automatically added to the image file name. 

 The image is analyzed using the image analysis settings and the microarray layout files 

associated to the BioApplication.  

 The analysis generates an intensity levels file that is saved.  

 The intensity levels file is required to generate the final report that consists in the creation 

of the E@syCheck project to obtain:  

o final check, a report indicating the list of targets turned on/off (as it is explained in 

Appendix B  Project management); 

o test result, a detailed list of targets in the panel and the “Detected / Not Detected” result 

for each target.  
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 To generate the report, the application uses the personal default rule. 

 The final analysis (Final Check and Test Result) is saved in a project file and linked in the local 
database. If a project file with the same name already exists, a time-stamp is automatically 
added to the project file name.  

 
 

 
Fig. 38: Acquisition and analysis completed with success. 

 
On the bottom left of the window, the Microarray Equivalent Image (MEI) is displayed instead of 
the original microarray image (MOI) obtained by the image analysis. This image is saved and never 
displayed by the E@syCheck tool. The MEI removes all the artifacts and gives a good perception 
of the microarray quality.  
 
On the bottom right, the results of the analysis are displayed. The default view is the Test Result 
(Fig. 38). The Final Check view can be displayed by clicking on the second tab and it indicates the 
list of targets and controls with their relative results (Fig. 39). 
The “Note” field is an editable text area for the user to input any information. For instance, it 
could be used for linking sample ID with chip ID. 
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Fig. 39: Final Check view. 

 
The user can maximize the MEI image by clicking on “Full Screen” button ([ ]) of the image (Fig. 
40). 

 

 
Fig. 40: MEI maximized 
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To return to the previous view, the user clicks on the same button of the image. 
 
The information shown in the “New Report” window can be translated into a PDF format by 
clicking the “Print Report” button on the toolbar or selecting the menu “File -> Print Report…” 
item. 

 

 
Fig. 41: Print Report selection. 

 
The “Print Report” section has a few options. The page layout can be changed between Portrait 
and Landscape. Also, there is an option to include the microarray image. The user can also add 
their own company logo to the report. 

 

 
Fig. 42: Print Report options. 
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After selecting the options, the user can click on the “Print” button to bring up the navigation 
window shown below. This allows the user to define the location of where the PDF report will 
be saved. 

 

 
Fig. 43: PDF Report location. 

 
The PDF report is shown in the following window (Fig. 44): 

 

 
Fig. 44: Print Report window 
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This PDF file contains all the info for each sample and is compressed in 1-2 page. The information 
includes:  

 Name of the chip, the user ID, the date and time and the test result, 

 Microarray image if selected, 

 Final Check results which has the full list of targets and detection status. 
 

In case of artifacts and noise on the microarray, it is possible that some spots are not perfect 
according to algorithms in the software (applied during the image analysis) that determinate 
good, bad and empty spot. The E@syCheck tool manages, in terms of microarray interpretation 
results, the presence of ‘bad spot’ flags among the capture and controls probes. This ‘bad spot’ 
management is described in the diagnostic rules. 
 
In the MEI, the ‘bad spot’ are displayed in red. The color is proportional to their “Signal Median 
– Background Median” value.  

 
Fig. 45: Bad Spot in MEI 

 
In the Final Check list, the user can see some target or control in red color. These contain the 
probes that are identified as bad spots. If the user clicks on one of these red targets, the user can 
view the list of bad spots belonging to the selected target or control. 
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Fig. 46: List of warning for a target 

 

6.4.4 Error during Acquisition operation 

The Optical Reader should be turned on before launching E@syCheck software as the software 
initializes the camera upon starting. 
During the “Acquisition” operation, If there is a power trip or if the Optical reader is turned off 
and on, the software will detect when the Optical Reader is power cycled.  

 

 
Fig. 47: E@syCheck error 

 
The reader messages can be dismissed. To resolve this error, close E@syCheck and restarting it 
will re-initialize the camera. 

 
In case of bad alignment due to artifacts and noise on microarray, a Microarray Filtered Image 
(MFI) is displayed with the relative grid alignment. The MFI is obtained by the original acquired 
image, removing some artifacts and giving a good representation of the microarray quality.  In 
this case, the E@syCheck tool allows the following choices: 

 Ignore the warning, if the shown grid alignment is correct. 

 Manual analysis, if the grid alignment is not exact and the user wants to start a manual 
analysis. 

 Abort, if the user wants to stop the analysis. 
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Fig. 48: Alignment warning and MFI 

 
If the user selects the “Ignore warning” option (Fig. 48), the analysis continues as explained above. 
If the selected option is “Manual analysis”, then H-MAT tool is launched and E@syCheck 
application is minimized. H-MAT shows a microarray filtered image (MFI) and the original grid 
with the purpose to help user in the alignment. 

 

 
Fig. 49: H-MAT grid alignment 
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The user has to align the grid manually and then click on “Resume” button to start the image 
analysis (Fig. 50). 

 

 
Fig. 50: H-MAT 

 
When the progress is completed, the image analysis is finished and H-MAT will be closed 
automatically. E@syCheck will continue the processing up to the diagnostic analysis. 

 
Fig. 51: Manual analysis result 

 
If the selected option is “Abort analysis”, then the analysis is stopped and an error message is 
displayed in the Final Result frame. 



IFU-PLX-RA01-1002 

 

 

VerePLEX™ Biosystem Software     Page 57 of 85  
                                                                               

6.4.5 Chip traceability 

In order to trace the single chip from the start to the end of an experiment and to avoid reusing 
the same chip, it is necessary to store in the database the steps performed. 
In particular, after an “Acquisition” operation is performed for a chip, E@syCheck tool saves in 
the database all the information necessary to trace a chip. When the user inserts the barcode of 
a used chip, the application shows the following warning message: 

 

 
Fig. 52: Confirm Chip reuse 

 
The usual steps for a chip acquisition will be followed if the user selects “Yes”. If the user selects 
“No”, all the information related to the chip ID is deleted in the software. 

 

6.4.6 Report option (administrator only) 

The user can view the chip and analysis information of all reports saved in the local database. As 
a default, those displayed are the last ten reports saved in the database. The display shows the 
latest report on top. If the user wants to show more or less than ten reports, the user can select 
the menu “View -> Report Option…” to set the number of the last reports to visualize.  

 

 
Fig. 53: Report Option Window 

 
If the user clicks on a report row, the relative image and the final results will be displayed in the 
bottom of the window. 
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Fig 54: Saved report view 
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6.4.7 Switching Between Applications 

 
The “Platform” menu provides a quick access to switching between E@syCheck, E@syControl 
and E@syManager. User can also use the “Platform” button in the toolbar (Fig. 55). 

 

 
Fig. 55: Platform menu 

 
 

The menu "Help -> Contents…” item will launch the VerePLEX™ IFU (Fig. 56). 
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Fig. 56: Help menu 

 
The menu "Help -> About E@syCheck” item shows the general information about E@syCheck 
tool (Fig. 57). 

 

 
Fig. 57: About E@syCheck window 

 
If the user checks the menu “Virtual Keyboard” item in E@syManager tool before the E@syCheck 
launch, a virtual keyboard will be shown every time that the user clicks on a text area. 
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6.5 E@syManager Operation 

 
This application allows the user to manage the security of the VerePLEX™ Biosystem Software. 
This tool includes the features to create and manage user accounts and groups. The 
Administrator can make workgroups and define the permissions and privileges related to every 
VerePLEX™ Biosystem Software application. The Standard User can only view the account data. 
 
Upon launching E@syManager, the user is required to log in (Fig. 58). 

 

 
Fig. 58: Login 

 

6.5.1 List Toolbar 

The “List” toolbar provides access to the list of items that is used globally in the software: 

 Group → Provides group level access control. The levels are UserAdmin, PowerUser, User. The 

SysAdmin is for Service Engineer access control. 

 User → List of users with their assigned default BioApplication. Users are linked to group level.  

 Lock → List of applications currently in used and is locked. The lock is removed when the 

application is closed. In the event there is a sync error and an application is locked, the admin 

can delete this record from this list. 

 BioApplication → List of BioApplications that are installed in the system. The BioApplications 

contains all the settings required for a particular chip run and microarray image analysis. 
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 TCS → List the status of the connected TCMs and if they are in used by any user. 

 View → List the different type of views which can be created in the E@syManager. 

 
 

 
Fig. 59: List function 

 

6.5.2 Creating New Group (admin only) 

There are three default groups with defined access controls. The admin can create more groups 
and the access controls will be linked to either Power User or Standard User. The admin cannot 
create more admin access level groups. 
 
To create a new group to allow users to have the permission to access to the applications of 
VerePLEX™ Biosystem and to configure some customizable features, the admin has to click “New 
 Group” in the toolbar of the main window or select the menu “File  New  Group”. 
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Fig. 60: New Group 

 
The application will show the “New Group” window with several parameters. The admin can 
create different groups. Each one will be characterized by a sub-set of VerePLEX™ Biosystem 
application that users can use. 
 
A Default BioApplication should be assigned to each group. When a new user is assigned to this 
group, their default BioApplication would follow what is assigned in the group. 
 
The admin and Power Users would also be able to assign their own BioApplication in the 
E@syControl and E@syCheck applications and it would overwrite the current setting. Standard 
Users would not be able to assign their own BioApplication in the E@syControl and E@syCheck. 
Also, when a user who is assigned a BioApplication is deactivated or removed, it would revert to 
the default Group BioApplication. 
 
It is possible to create an account to login in E@syControl as standard user and another account 
to login as power user, as showed in the following picture: 
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Fig. 61: New group account 

 
The admin can save the group and the list of the groups stored in the database will be shown in 
the Groups List window.  
 
Only the Service Engineer can create multiple admin groups. 

 

6.5.3 Creating New User (admin only) 

To create a new user and to allow users to have the permission to access to the applications of 
VerePLEX™ Biosystem, the admin has to press “New  User” in the toolbar of the main window 
or select the menu “File  New  User”. 
 

 
Fig. 62: New user 
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To create a new user, it is necessary to insert data in the text area of the “New User” window. 
The Administrator has to insert: (* indicates compulsory fields) 
o Name of the user * 
o Surname of the user 
o Email  
o Username * 
o Password * 
o Confirmation of password* 

 
Next, the admin has to select the group to which the user belong to and also assign the Default 
BioApplication. Finally the admin can save the group and the list of the users stored in the 
database will be showed in the main window.  
 
Only the Service Engineer can create multiple administrators. 

 

6.5.4 New View (All user access levels) 

To create a new view to visualize data in accordance to parameters set by user, the admin has to 
press “New  View” in the toolbar of the main window or select the menu “File  New  View”.  

 

 
Fig. 63: New view 

 
To set the fields that the user wants to show, the width and other parameters, the admin has to 
press the “New View” button and insert and select: 

 
o The entity in which to apply the settings 
o The name of the new customizable view of the data 
o The number of record for page  that he wants to show 
o The fields to show and the width for each. 

 
The user has to check the “Set default view” if the view is to be the default view when user log in 
the application the next time. The admin can save the view and the list of the views stored in the 
database will be shown in the main window.  
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6.5.5 BioApplication 

The BioApplication is provided with each chip application and provides all pre-defined settings 
required for chip run and microarray image analysis. These settings cannot be modified. If there 
is any update or customization, it has to be done by the service personnel.  
 
A BioApplication is defined as a set of input data/files: 

 Layout of the Microarray 

 Temperature Program 

 Settings for the microarray image analysis. 

 Diagnostic rule 

 Reader parameters 
 

The selection of the BioApplication allows the software to load automatically the data in the 
related tools and instruments avoiding/reducing the human errors. The BioApplication selection 
allows all users to load input data in a simple and unambiguous way. All BioApplications will be 
stored in the Central Database. 
 

6.5.6 TCS Chip Traceability  

The Administrator has to click on “TCS Chip” button in the list bar of the main window or the “TCS 
Chip” button in the toolbar (Fig. 64). 

 

 
Fig. 64: TCS Chip traceability 
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The information listed is: 

 Barcode number 

 TCS serial number and TCM number 

 Temperature program file 

 BioApplication name 

 TCM state (0 = init phase not runned, 1 = run completed) 

 TCM error (errors code: 0=Init, 1=completed, 100=Over temperature, 101=Temperature out 
of range, 102=Lid open, 103=TCM stopped, 104=Reset, 105=Not completed) 

 Date of completed or interrupted temperature program run 

 PC name 

 User name 
 

6.5.7 OR Chip Traceability  

It is possible to list the all the information related the chip ID management in the OR. The admin 
can click on the “OR Chip” button in the toolbar to display this information. 

 

 
Fig. 65: OR Chip traceability 

 
 

The information listed is: 

 Barcode number 
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 BioApplication name 

 Layout Microarray file 

 Image analysis Settings file 

 OR serial number 

 Optical Reade error status (see the table below) 

 Number of acquisitions for LOC  

 Date of completed or interrupted image analysis 

 PC name 

 User name 
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 Chapter 7 

7 Maintenance 

7.1 Cleaning 

 
DO NOT perform any cleaning operation with the system turned on. Before starting these kind of 
action always switch OFF the system by placing rear panel button in 0 position and detaching 
power cord from AC high power socket. The instrument external cases may be cleaned with a soft 
cloth soaked with isopropanol or ethanol.  
 
For further maintenance, it has to be performed by qualified service engineer. 

 

7.1.1 Technical service  

 
If you require technical service or replacement parts, please contact your local sales representative 
or dealer who sold the product.  
 
Please provide the following information: 
•  Model name and serial number of the instrument. 
•  Location of the instrument and name of the person to contact. 
•  Reason for the service call. 
•  Date of delivery. 

 

7.1.2 Disposal 

 
The instruments contain electrical or electrical materials and should be disposed of as unsorted 
waste. It must be collected separately, according to European Union Directive 2202/96/CE on 
waste and electronic equipment – WEEE Directive. Before disposal, contact your local Veredus 
representative for country specific instructions. 

 

7.2 Calibration 

 
Calibration is recommended once every 12 months or in case of any serious problem, the TCS and 
OR must undergo calibration maintenance and the calibration have to be carried out by certified 
personnel or trained personnel appointed by Veredus. To schedule a calibration, contact your local 
distributor or Veredus Laboratories. 
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7.3 TCS Troubleshooting 

 
A standard operator or user shall not open the equipment in case of any repairs or actions that 
have to be taken. This operation shall be executed only by authorized technical personnel after 
the equipment is isolated or disconnected from the hazardous live voltage. 
 
Possible failure modes and troubleshooting actions are listed in the table below: 
 

SN Failure description Cause Actions to be taken 

1 TCS does not turn ON 

Power switch is turned  OFF  Place the switch in ON position 

TCS power cord is not 
connected to TCS or to mains 
AC   

Check connections 

Fuses are damaged or  missing Check fuses and replaces the defective ones 

Internal short circuits 
Disconnect the machine from AC main and 
call service. 

Power AC/DC converter is 
damaged, or burned out 

Disconnect the machine from AC main and 
call service. 

2 Embedded PC resets 

PC reset key has been touched  Turn the TCS OFF, then restart  

Power supply voltage drop Check fuses and replace the burned ones 

Bad insertion of CF card 
Turn the TCS OFF. 
Check CF card insertion 

3 
TCS does not give any 
response to mouse and 
keyboard 

Connecting cable is  
disconnected or badly 
connected to PC 

Check cable and/or replace it 

Mouse or keyboard are 
disconnected or badly 
connected to PC  

Check cable and/or replace it 

4 
TCM’s display  is ON but Led 
does not light 

LED is damaged 
TCM can be used and monitored  by 
E@syControl 

5 
TCM’s status led lights but 
display is OFF 

Display is damaged 
TCM can be used and monitored  by 
E@syControl 

6 
Temperature control is out of 
specifications 

Chip is defective or damaged Substitute  the chip 

Equipment is damaged 

If damage is only pertaining to a particular 
TCM, do not use it. 
If system damage seems to be present, 
disconnect the machine from AC main and 
call service. 

7 
System does not reach or 
keep the set temperature 

Defective TCM module Rerun the chip in another TCM module 

Defective chip 
Confirm by running the chip in another TCM 
module. If the same error occurs, it is Chip 
related. 

Ambient temperature too high 
Check that the ambient temperature does 
not exceed 30oC 

8 High power consumption 

Sealing are damaged or leaking, 
fluid is evaporated 

Check the chip. 

Internal TCM short circuit 
Disconnect the machine from AC main and 
call service. 
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SN Failure description Cause Actions to be taken 

Internal power supply is 
defective 

Disconnect the machine from AC main and 
call service. 

9 TCM hatch does not close 

Chip badly positioned Reposition the chip 

External bodies inside the TCM 
Check that there are no foreign items in the 
TCM 

Lock is damaged 
TCM functionalities are compromised. To 
resume it contact service personnel 

10 Opening key is blocked 
TCM opening mechanism is 
blocked 

Apply a slightly pressure on the hatch and 
press the opening key again 

11 TCM hatch does not open 

Chip badly positioned Reposition the chip 

Lock is damaged 
TCM functionalities are compromised. To 
resume it contact service personnel 

TCM opening mechanism is 
blocked 

Apply pressure on the hatch and press the 
opening key again 

12 Chip does not fit in the TCM 

External bodies inside the TCM 
Check that there are no foreign items in the 
TCM 

Contact holder or positioning 
pins are damaged 

TCM functionalities are compromised. To 
resume it contact service personnel 

Defective chip Repeat experiment with another chip 

13a 
TCS icon does not become 
active in the E@syControl 

Ethernet wire is not connected  Connect Ethernet wire 

TCS IP address is not configured 
in the E@syControl 
Configuration Menu 

Contact Veredus or local representative to 
configure IP address in the E@syControl 

TCS has a LAN  forbidden IP 
address 

Contact Veredus or local representative to 
configure IP address in the E@syControl 

TCS has wrong IP address 
Contact Veredus or local representative to 
configure IP address in the E@syControl 

A firewall could be active in the 
laptop/PC, that forbids the 
connection 

Check if the Firewall is deactivated  

Some overcrowding in the 
TCP/IP communication from PC 
and TCS. 

Perform the following steps:  
1) Close the SW 
2) Re-launch the SW. 
If the problem persists: 
1) Reboot the TCS 

13b 
TCS  icon does not become 
active in the E@syControl 

Control Module problem.  Reboot the TCS 

    
TCS IP address is not configured 
in the E@syControl 
Configuration Menu 

Contact Veredus or local representative to 
configure IP address in the E@syControl 

14 
TCM LCD stops on status 
“TCM No xx CONNECTING” 

Bad  connection between TCS 
(Embedded PC) and that TCM 

Check internal cables and backplane  

15 

TCM LCD stops on status  
“E2P    ADC  FAN” 
“FAIL  PASS  PASS” 
with red blinking light 

PC board TCM hardware error 
Need to replace TCM. Contact service 
personnel. 

16 

TCM LCD stops on status  
“E2P    ADC  FAN” 
“PASS  FAIL  PASS” 
with red blinking light 

PC board TCM hardware error 
Need to replace TCM. Contact service 
personnel. 



IFU-PLX-RA01-1002 

 

 

VerePLEX™ Biosystem Software     Page 72 of 85  
                                                                               

SN Failure description Cause Actions to be taken 

17 

TCM LCD stops on status  
“E2P    ADC   FAN” 
“PASS  PASS  FAIL” 
with red blinking light 

FAN error 
Service is needed to check fan cable. 
Contact service personnel. 

18 
More TCS with same IP 
address 

No connection with any TCSs 
Contact Veredus or local representative to 
configure IP address in the E@syControl 

19 
E@syControl has wrong IP 
address 

No connection 
Contact Veredus or local representative to 
configure IP address in the E@syControl 

20 Missing calibration data 

It is not possible to send 
calibration data to TCM 
because calibration files are not 
installed or corrupted 

Need calibration data files. Contact service 
personnel 

21 2D barcode unreadable  
It is not possible to send the 
Chip ID and calibration data to 
TCM 

User can change the settings of 2D barcode 
to read the linear barcode present upon the 
Chip. Need calibration data files. Contact 
service personnel 

22 
Temperature Program 
stopped 

It is possible that user has 
opened the lid 

Close the lid and Press the START button 
from TCM or SW GUI 

It is possible that user has 
stopped the TCM unawares 

The SW has to allow to the user to create a 
temperature program to complete the run 

It is possible that user has 
stopped the TCM unawares in 
the fluidic phase 

The SW has to allow to the user to send a 
temperature program to complete the run 

23 

Automatic protocol sending 
unavailable 

BioApplication files not found 
or corrupted 

Need BioApplication files. Contact service 
personnel 

User sends a wrong 
temperature program to TCS 

Wrong BioApplication selected 
as default  

Select the correct BioApplication by 
BioApplication management window. 

24 
The E@syControl GUI is not 
refreshed properly 

TCM Progress bar does not start 
or it is not correctly updated  

Close the E@syControl and re-launch it. 
After the connection is established the SW 
will be able to synchronize the data 
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7.4 OR Troubleshooting 
SN Failure description Cause Actions to be taken 

1 The OR does not turn on 

Power Switch (5) is turned OFF  Turn the Power Switch (5) ON 

Power Supply Jack (3) is 
disconnected 

Connect the Power Supply Jack to the 
OR (3)  

Power supply cables are 
damaged or broken 

Contact service personnel. 

AC Power Supply Cord (1) is not 
connected 

Check that the power supply cord is 
securely connected. 

External Power Supply (2) over 
current protection has tripped 

Check the Low Voltage Cable for shorts - 
Check the OR control board  

External Power Supply 
defective 

Contact service personnel to replace the 
Power Supply  

2 
The OR is switched on and 
working, but the Power 
Status Led (9) remains off 

Power Status Led (9) defective 
The Power Status Led (9) is to be 
replaced 

Power Status Led (9) wiring 
interrupted or disconnected 

Check Power Status Led (9) wiring and 
reconnect or replace if defective 

3 
Chip insertion difficult or 
impossible 

Vertical / horizontal 
misalignment  

Reduce the insertion angle in order to 
better align the chip perpendicularly to 
the Slotted Insertion Plate (11) 

Presence of foreign materials in 
the inlet slot of Insertion Plate 
(11) 

Check the Insertion Plate (11) 
cleanliness  

Insertion Plate (11) out of 
alignment  

Re-align the Insertion Plate 

4 
The Chip gets stuck before 
reaching the reading 
position (end of travel) 

Presence of foreign materials 
(e.g. glass chips) in the internal 
guide 

Remove any foreign material from the 
internal guide 

5 
No image from the OR 
camera 

The Ethernet cable is 
disconnected 

Check the Ethernet cable 

6 

Fluorescent spots are 
visible outside the 
detection area (after 
acquisition) 

The anti-glare mask is dirty or 
stained 

The instrument needs technical service 

7 
Glass chips in detection 
area 

A chip has been damaged in the 
loading/unloading phase 

The instrument needs technical service 

One or more optical 
interference filters have been 
broken 

The instrument needs technical service 
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SN Failure description Cause Actions to be taken 

8 Alignment fail for all Chips Wrong crop setup 

Close E@syCheck 
Insert a good Chip inside Reader 
Open H-EA 
Open crop window in the menu Option 
Press on "Search Crop button" 
Press Save and close H-EA 
Restart E@syCheck 

9 Acquired image is blurred 

Chip is not in the correct focus 
position  

Extract and reload the Chip. 
Try a new acquisition. 

CCD camera is off the focus 
position 

unscrew the Focus Adjustment Lock (7) 
and go through the focus adjustment 
procedure 

10 
Acquired image has low 
contrast  

Moisture has condensed over 
the optical components 

Let the OR in a warm and dry place until 
moisture evaporates 

One red LED light source has 
failed 

The instrument needs technical service 

Internal optical parts are dusty The instrument needs technical service 

CCD camera defective The instrument needs technical service 

11 No image is acquired 

Both light sources failed The instrument needs technical service 

The main control board has 
failed 

The instrument needs technical service 

 

7.5 TOM Troubleshooting 
SN Failure description Cause Actions to be taken 

1 TOM does not turn on 

Power Switch is turned OFF  
Turn the Power Switch on the back panel 
of the screen 

Power Supply Jack is disconnected 
Connect the Power Supply Jack and check 
that the power supply is turned on 

Power supply cables are damaged or 
broken 

Contact service personnel 

2 
Power turned on but 
no display 

Display cable not connected properly 
Check that the VGA cable is securely 
connected to the TCS and also the 
Monitor 

TCS not turned on 
Check that the Base TCS is turned on. 
Try rebooting the TCS. 

3 
Touch functionality 
not working 

USB cable not connected 
Ensure that that the USB able is connected 
securely to the TCS and also the Monitor 

Touch driver corrupted 
Contact service personnel for driver 
installation 



IFU-PLX-RA01-1002 

 

 

VerePLEX™ Biosystem Software     Page 75 of 85  
                                                                               

 

Chapter 8 

8 Technical specifications 
TCS dimensions:  

 

Length (mm) Width(mm) Height(mm) 

500 300 145 

 
OR dimensions:  

 

Length (mm) Width(mm) Height(mm) 

190 180 320 

 
TOM dimensions:  

 

Length (mm) Width(mm) Height(mm) 

280 310 300 

 
 

TCS mass: 10 Kg 
OR mass: 3.8 Kg 
TOM mass: 5.5 Kg 

 

 

TCS Technical Specifications 

*Temperature control range 

Tenv=26 °C   T  40 °C - 100 ºC 
Tenv=30°C    T  43 °C - 100 ºC 
Tenv=35 °C   T  48 °C - 100 ºC 
 

Temperature Control Accuracy ±0.2 ºC 

Heating rate 25 ºC/sec 

Cooling rate 4 ºC/sec 

Falling and rising ramp 
thresholds in dry conditions at 
26°C 

Rising ramp 50-95 °C 33 °C/sec ±20% 

Falling ramp 95-72 °C 10 °C/sec ±20% 

Falling ramp 72 -50 °C 6 °C/sec ±20% 

Size 500mm x 300mm x 145mm 

Weight 10 Kg 
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Power supply 110/220 VAC, 50/60Hz 

Communication ports 
2 LAN 
6 USB 

I/O ports 
1 VGA, 
1 serial RS-232 

TCM Display LCD 16x2 blue back lighted 

Consumption 140W Maximum 

Over voltage category Category I 

Safety class Class 1 

Noise level < 68.9 dBA 

Storage conditions -10°C-50°C, Humidity 20%-80% 

Operating conditions 10°C-30°C, Humidity 20%-80% 

Preconditioning time 
2 hours at ambient temperature, mandatory before 
use 

Firmware SW Version 5.01 

Control Module Version  5.00 

SW Library version Version  5.20 

OS x SW Library Windows XP Embedded 
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VerePLEX Biosystem Software minimum requirements 

Processor 1.5 Ghz or more 

RAM memory 512MB 

Mass storage 250 MB of HDD 40GB, CDROM (for installation) 

Communication 2 x Ethernet ports (10/100 Tbase), 2 USB port 

External accessory 2D Barcode reader 

Operating system Windows 10, Windows XP embedded 

SW application VerePLEX Biosystem Software 5.3.0 or later 

 
 

OR Technical Specifications 

Sample size Single slide: 
Length 74.9 mm – 75.1 mm  
Width 24.9 mm – 25.1 mm  
Thickness 1 mm – 1.1 mm  

Field of view 9.2x7 mm 

Acquisition time Selectable form 1 to 4095 ms 

Detector ½’’ progressive scan CCD 1392x1040 pixels 

Pixel resolution 6,67 m 

Illuminators High power LEDs, 635 nm 

Excitation filter Center wavelength 628 nm, 40 nm wide band-pass 
filters 

Excitation power 10±2 mW onto the detection area 

Emission filter Center wavelength 692 nm, 40 nm wide band-pass 
filters 

Dynamic linear range 8-bit, (255:1) in single acquisition mode 

Repeatability Less than 3% of CV 

Uniformity Less than 8% of CV 

Sensitivity  25 chromophores (Cy5)/μm2 (CPSM) at a signal-to-
noise ratio of 2:1  

Software E@syCheck 

Image format 16-bit Tiff or Bmp 

Dimensions 18 L x 18 W x 31 H (cm) 

Weight 3.6 Kg 

Power Voltage: 12 Vdc, 18 W 
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TOM Technical Specifications 

Monitor Size 10.4" 

Resolution 800x600 

Brightness 230 (cd/m2) 

Touch screen Type 5-wire Resistive Touch screen 

Touch screen Durability 36 million touches 

Dimensions 31 x 28 x 30 (cm) 

Weight 5.55 kg 

Environment 

Operating Temperature 0oC - 45oC 

Storage Temperature -20oC - 60oC 

Humidity 
5 - 95% @40oC, non-
condensing 

System 

I/O VGA, USB 

Power 
36W power adapter, with AC 
100~240 V input and DC +12V 
@ 3A output 
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Chapter 9 

9 Glossary 
IFU = Instructions for Use 
API = Application program interface 
Chip = VereChip™ 
HYB = Hybridization  
LCD = Liquid Crystal Display 
PCR = Polymerase Chain Reaction 
TCM = Temperature Control Module 
TCS = Temperature Control System 
OR = Optical Reader 
TOM = Touch Monitor 
FIRM = Firmware 
EB = Electronic Board 
ECH = E@syCheck software 
ECO = E@syControl software 
H-EA = Express Acquisition software 
H-MAT = Microarray Analysis software 
TPE = Temperature Protocol Entities 
CLT = Calibration Data 
GUI = Graphical User Interface 
CF = Compact Flash 
SW = Software 



IFU-PLX1.0 

 

 

VerePLEX™ Biosystem Software     Page 80 of 85  
                                                                               

10 Appendix A – List of requirements for VerePLEX™ Platform installation 
 
 

 
 

 Desktop/Laptop: IEEE 802.3 Ethernet board for each PC where the OR and TCS has to be 
connected. 

 

Cable requirements for connecting the TCS, OR and TOM to the Power Network 
 
 Power cords, minimum length 1.5 meters, are included in the shipment package 

 
 

 

 
TCS, OR and TOM power cords end with a SCHUKO/IEC 16A plug.  
You can make it suitable to the Power Network by using an adaptor 
or changing the power cord. 
 

 

 

TCS Power supply 
 
Input Voltage: 100 - 240 Vac (extended range 90 ¸ 264 Vac) 
Input Frequency: 50 - 60 HZ (47 - 63Hz) 
Input power: 260W maximum 
Automatic switching 
  

 

 

READER AC/DC Converter 
 
Switching AC Adapter input features: 
100-240 Volt AC  
0.4 Ampere 
50-60 Hz 
 
Switching AC Adapter output features: 
12 Volt DC  
2 Ampere 
Center Positive  

 

 

TOM Power supply 
 
Switching AC Adapter input features: 
 
100-240 Volt AC  
1.5 Ampere 

Hardware requirements for TCS-03 and OR-02 PC-Connection  
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50-60 Hz 
 
Switching AC Adapter output features: 
 
12 Volt DC  
3 Ampere 
Centre Hole Positive  
Outer metal sleeve connected to Negative  

 
 
 

Other devices 
 
 2D Barcode Reader compatible with Data Matrix. 
 

 
Please verify that the Barcode Reader connector is compatible with the 
laptop available ports. 

 

  



IFU-PLX1.0 

 

 

VerePLEX™ Biosystem Software     Page 82 of 85  
                                                                               

11 Appendix B – Standard user, power user and admin 
 

The VerePLEX™ Biosystem software has different user access levels that can login the application 
according to different type of users:  

 

 Standard User. In this case the user can perform only the following operations: 
o send protocol to TCMs 
o start and stop a single PCR/HYB process 
o capture Microarray image 

 

 Power User. In this case the user can perform the standard user operation and the additional one 
o access to BioApplication Mode (view, change) 
o reset single TCM 
o access to protocol management 

 

 Admin User. In this case the user can perform the power user operation and the additional one: 
o configure TCS 
o set BioApplication for other users 
o Create/modify groups and users 

o view/save log file 
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